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Chapter 743

Superiority by a
Margin Tests for
Simple Linear
Regression
Introduction
This procedure computes power and sample size for superiority by a margin tests of the slope in simple linear
regression. Simple linear regression is a commonly used procedure in statistical analysis to model a linear
relationship between a dependent variable Y and an independent variable X.
The details of sample size calculation for simple linear regression are presented in the Non-Zero Null Tests for
Simple Linear Regression chapter and they will not be duplicated here. This chapter only discusses those changes
necessary for superiority by a margin tests.

Difference between Simple Linear Regression and Correlation
The correlation coefficient is used when X and Y are from a bivariate normal distribution. That is, X is assumed to
be a random variable whose distribution is normal. The values of X will not be known until the study is
completed. In the simple linear regression context, no statement is made about the distribution of X. In fact, X
does not have to be a random variable. In this procedure the distribution of Y is conditioned on X.

Fixed or Random X
Gatsonis and Sampson (1989) present power analysis results for two approaches: unconditional and conditional.
This procedure provides a calculation for the conditional (fixed X) approach.
The unconditional approach assumes that X is normally distributed and is based on the correlation coefficient.
The normality assumption might occasionally be met, but not frequently. Our impression is that usually, the
values of X will not be known at the planning stage and they will not follow (even approximately) the normal
distribution. Hence, the only option available is to proceed with the sample size calculation using the conditional
approach and then estimate the standard deviation of the X’s as best you can.
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Technical Details
Suppose that the dependence of a variable Y on another variable X can be modeled using the simple linear
equation
Y = A + BX
In this equation, A is the Y-intercept, B is the slope, Y is the dependent variable, and X is the independent variable.
The nature of the relationship between Y and X is studied using a sample of N observations. Each observation
consists of a data pair: the X value and the Y value. The values of A and B are estimated from these observations
using the method of least squares. Using these estimated values, each data pair may be modeled using the
equation

Yi = a + bX i + ei
Note that a and b are the least squares estimates of the population parameters A and B. The e values represent the
discrepancies between the estimated values (a + bX) and the actual values Y. They are called the errors or residuals.
If it is assumed that these e values are normally distributed, tests of hypotheses about A and B can be constructed.
Specifically, we can employ a T-test to test the superiority of B compared to a superiority boundary B0.

Linear Regression Slope T-Test Statistic
It is anticipated that a one-sided t-test of a regression coefficient will be used to conduct the test. Hence, the
formula of the test statistic is
𝑡𝑡𝑁𝑁−2 =

𝑏𝑏 − 𝐵𝐵0
𝑠𝑠𝑏𝑏

where N is the sample size, b is the estimate of B, and sb is the standard error of b.

The Statistical Hypotheses
Non-inferiority and superiority tests are examples of directional (one-sided) tests and their power and sample size
could be calculated using the Simple Linear Regression with a Non-Zero Null procedure. However, at the urging
of our users, we have developed this procedure which provides the input and output options that are convenient
for superiority by a margin tests. This section will review the specifics of superiority by a margin testing.
Remember that in the usual simple linear regression setting, the null (H0) and alternative (H1) hypotheses for
one-sided upper-tail tests are defined as
𝐻𝐻0: 𝐵𝐵 ≤ 𝐵𝐵0

versus

𝐻𝐻1: 𝐵𝐵 ≥ 𝐵𝐵0

versus

𝐻𝐻1: 𝐵𝐵 > 𝐵𝐵0

Rejecting H0 implies that the slope is larger than the value B0. This test is called an upper-tail test because H0 is
rejected in samples in which the sample slope is larger than B0.
The corresponding lower-tail test is
𝐻𝐻1: 𝐵𝐵 < 𝐵𝐵0

Superiority by a margin tests are special cases of the above directional tests. It will be convenient to adopt the
following specialize notation for the discussion of these tests.
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Parameter
B

Interpretation
Population slope.

B1

Actual population slope at which power is calculated.

This parameter will be estimated using the method of least squares.
This is the assumed population slope used in all calculations.

B0

Superiority Slope.

This is the smallest (or largest) value of the slope for which the new
treatment will still be considered superior to the current treatment.

BR

Reference value.

Usually, this is the slope in the reference population.

SM

Margin of superiority.
This is a tolerance value that defines the magnitude of slope that is not of
practical importance. This may be thought of as the largest difference
from the reference value that is considered to be trivial.

Superiority by a Margin Tests
A superiority test tests that the slope is better than that of the baseline (reference) population by more than a small
margin. The actual direction of the hypothesis depends on the whether higher values of the response are good or
bad.

Case 1: High Values Good
In this case, higher values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that
the slope is greater than a small amount above the reference value. Equivalent sets of the null and alternative
hypotheses are
𝐻𝐻0: 𝐵𝐵 ≤ 𝐵𝐵0

𝐻𝐻0: 𝐵𝐵 ≤ 𝐵𝐵𝑅𝑅 + 𝑆𝑆𝑆𝑆

versus
versus

Case 2: High Values Bad

𝐻𝐻1: 𝐵𝐵 > 𝐵𝐵0

𝐻𝐻1: 𝐵𝐵 > 𝐵𝐵𝑅𝑅 + 𝑆𝑆𝑆𝑆

In this case, lower values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that
the mean of the treatment group is no more than a small amount above the reference value. Equivalent sets of the
null and alternative hypotheses are
𝐻𝐻0: 𝐵𝐵 ≥ 𝐵𝐵0

𝐻𝐻0: 𝐵𝐵 ≥ 𝐵𝐵𝑅𝑅 − 𝑆𝑆𝑆𝑆

versus
versus

𝐻𝐻1: 𝐵𝐵 < 𝐵𝐵0

𝐻𝐻1: 𝐵𝐵 < 𝐵𝐵𝑅𝑅 − 𝑆𝑆𝑆𝑆
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Power Calculation of the Superiority Test of the Regression
Coefficient, B
The following presentation is based on the standard results for a t-test as shown by Neter, Wasserman, and Kutner
(1983) pages 71 and 72.
The power for a superiority test in which higher values of B are better is calculated as follows for a one-tailed test
in which the statistical hypotheses are H0: 𝐵𝐵 ≤ 𝐵𝐵0 vs. H1: 𝐵𝐵 > 𝐵𝐵0.
1. Find 𝑡𝑡1−𝛼𝛼 such that 𝑇𝑇𝑑𝑑𝑑𝑑 (𝑡𝑡1−𝛼𝛼 ) = 1 − 𝛼𝛼, where 𝑇𝑇𝑑𝑑𝑑𝑑 (𝑥𝑥) is the area under a central-t curve to the left of x
and df = N – 2.

2. Calculate: 𝑋𝑋0 = (𝑡𝑡1−𝛼𝛼 )𝜎𝜎𝑒𝑒 /√𝑁𝑁.

3. Calculate the noncentrality parameter: 𝜆𝜆 = √𝑁𝑁(𝐵𝐵1 − 𝐵𝐵0)𝜎𝜎𝑋𝑋 /𝜎𝜎𝑒𝑒 , where 𝜎𝜎𝑋𝑋 is the standard deviation of the
X values in the regression and B1 is the slope at which the power is to be calculated.

4. Calculate: 𝑡𝑡1 = �𝑋𝑋0 − (𝐵𝐵1 − 𝐵𝐵0)𝜎𝜎𝑋𝑋 √𝑁𝑁/𝜎𝜎𝑒𝑒 � + 𝜆𝜆.

′
′
(𝑡𝑡1 ), where 𝑇𝑇𝑑𝑑𝑑𝑑,𝜆𝜆
(𝑥𝑥) is the area to the left of x under a noncentral-t curve with degrees
5. Power = 1 − 𝑇𝑇𝑑𝑑𝑑𝑑,𝜆𝜆
of freedom df and noncentrality parameter 𝜆𝜆.

The power for the case in which lower values of B are better is calculated using a test in which 𝐻𝐻1: 𝐵𝐵 < 𝐵𝐵0.

The sample size can be easily found using a binary search with this power formula.

Calculation of σX
The above calculation requires the value of 𝜎𝜎𝑋𝑋 , the (population) standard deviation of the X values in the regression
analysis. Except for the occasional experimental design that includes a specification of the X values (e.g., doses), the
specific X values are unknown in the planning phase. Hence, a reasonable estimate must be found. PASS includes a
special tool called the Standard Deviation Estimator that will aid in your search for accurate estimates of this
parameter.
The following table provides examples of typical data configurations and their corresponding standard deviations.
𝝈𝝈𝑿𝑿

X Values

1.000

1, 3

0.500

1, 2

1.500

1, 4

2.000

4.000

1, 5

1, 9

𝝈𝝈𝑿𝑿

X Values

1.633

1, 3, 5

0.816

1, 2, 3

2.449

1, 4, 7

3.266

6.532

1, 5, 9

1, 9, 17

𝝈𝝈𝑿𝑿

X Values

2.236

1, 3, 5, 7

1.118

1, 2, 3, 4

3.354

1, 4, 7, 10

4.472

8.944

1, 5, 9, 13

1, 9, 17, 25

𝝈𝝈𝑿𝑿

X Values

2.828

1, 3, 5, 7, 9

1.414

1, 2, 3, 4, 5

4.243

1, 4, 7, 10, 13

5.657

11.314

1, 5, 9, 13, 17

1, 9, 17, 25, 33

Because of the direct impact on the power and sample size, it will be important to spend some time determining
appropriate values for this parameter.
One final note: when a basic pattern is repeated, its population standard deviation remains the same. For example,
the standard deviation of the values 1, 2, 1, 2, 1, 2, 1, 2 is 0.5. This is also the standard deviation of 1, 2 or 1, 2, 1,
2.

743-4
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Superiority by a Margin Tests for Simple Linear Regression

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power for a power analysis or Sample Size for sample size determination.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power of an experiment.

Superiority by a Margin Test
Higher Slopes Are
Use this option to specify whether higher values of B (slope) are interpreted to be better or worse than lower
values. This in turn determines the direction of the hypothesis test.
•

Better
If B2 > B3, then B2 is better than B3. The higher, the better. The statistical hypothesis tested is H0: B ≤ B0
vs. H1: B > B0.

•

Worse
If B2 < B3, then B2 is better than B3. The lower, the better. The statistical hypothesis tested is H0: B ≥ B0 vs.
H1: B < B0.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error (alpha). A type-I error occurs when
you reject the null hypothesis when in fact it is true.
Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means
that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that
represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
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Sample Size
N (Sample Size)
Enter one or more values for the number of observations (e.g., subjects) in the study.

Effect Size – Slope
B0 (Superiority Slope) when Higher is Better
Enter one or more values for B0, the superiority boundary in the case when higher slope values are desired.
Suppose Bʀ is the reference slope value. The superiority by a margin test requires us to state how much greater
than Bʀ a slope must be so that we are willing to conclude that the slope value is superior to Bʀ. In this case, B0 =
Bʀ + |SM| where SM is the superiority margin.
B0 is set to a value greater than Bʀ and the alternative hypothesis is that B > B0.
The statistical hypotheses tested is H0: B ≤ B0 vs. H1: B > B0.
Note that neither Bʀ or SM is actually entered in the analysis.
For example, suppose Bʀ = 10. We might set B0 to 12 or 15.
Range
B0 can be any value, positive or negative, so long as B0 > Bʀ.
This value must be in the same scale as σх.
B0 (Superiority Slope) when Higher is Worse
Enter one or more values for B0, the superiority boundary in the case when lower slope values are desired.
Suppose Bʀ is the reference slope value. The superiority by a margin test requires us to state how much lower
than Bʀ a slope must be so that we are willing to conclude that the slope value is superior to Bʀ. In this case, B0 =
Bʀ - |SM| where SM is the superiority margin.
B0 is set to a value slightly less than Bʀ and the alternative hypothesis is that B < B0.
The statistical hypotheses tested is H0: B ≥ B0 vs. H1: B < B0.
Note that neither Bʀ or SM is entered in the analysis.
For example, suppose Bʀ = 10. We might set B0 to 8 or 5.
Range
B0 can be any value, positive or negative, so long as B0 < Bʀ.
B1 (Slope|H1) when Higher is Better
Enter one or more values of the slope assumed by the alternative hypothesis, B1. This represents the actual value
of B at which the power is computed.
You should make sure than B1 > B0.
You can enter a single value such as ‘1’ or a series of values such as ‘1 2 3’ or ‘1 to 10 by 1”.
B1 (Slope|H1) when Higher is Worse
Enter one or more values of the slope assumed by the alternative hypothesis, B1. This represents the actual value
of B at which the power is computed.
You should make sure than B1 < B0.
You can enter a single value such as ‘1’ or a series of values such as ‘1 2 3’ or ‘1 to 10 by 1”.
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Effect Size – Standard Deviation of X
σх Input Type
Select the method you want to use to enter the value(s) of σх. Your choices are
•

σх (Std Dev of X)
Enter one or more values for σх directly.

•

List of X Values
Enter a list of two or more numbers from which the standard deviation is to be calculated.

σх (Standard Deviation of X)
Enter one or more values for σх, the population standard deviation of the X values that will occur in a sample.
Usually, the actual X values are not known at the planning stage. When they are not known, you will have to
estimate this value. You can press the Standard Deviation Estimator button at the right to obtain help in
determining appropriate values for this parameter. Just be sure to use the population, not the sample, formula.
That is, divide the sum of squares by N, not N-1.
The individual numbers can be any numeric value: positive, negative, or zero.
Fixed Xs
Determine the standard deviation of a typical set of fixed Xs. For example, suppose the X values will be five -1's
and five 1's. The population standard deviation of these values (dividing by N, not N - 1) is 1.0. This is the value
of σх. Note that '1 2' will result in the same σх as '1 2 1 2', '1 1 1 2 2 2', '-1 -2', or '11 12'.
Random Xs
Estimate one or more values of σх, the standard deviation of X, from your knowledge of X. If nothing else is
available, you can use the likely range divided by 4, 5, or 6.
List of X Values
Enter a list of values from which the value of σх will be calculated. For example, entering "1, 3" results in
σх = 1.0. Note that this calculation assumes that the N observations are allocated equally among the X's.

Effect Size – σe (Standard Deviation of Residuals)
σe Input Type
Select the method to use to enter σe (the standard deviation of the residuals).
•

σe (Std Dev of Residuals)
Specify σe directly.

•

σʏ (Std Dev of Y)
Specify σʏ. Calculate: σe² = σʏ² - B1² (σх²)

σe (Std Dev of Residuals)
Enter one or more values of the standard deviation of the residuals from the regression of Y on X. The possible
range is 0 < σe.
σʏ (Std Dev of Y)
Enter one or more values for the standard deviation of Y, ignoring the independent variable X. The value of σʏ is
converted to σe using the formula: σe² = σʏ² - B1² (σх²). The allowable range is 0 < |B1(σх)| < σʏ.
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Example 1 – Calculating the Power
Suppose a power analysis is required for a simple linear regression study that will perform a superiority test the
relationship between two variables, Y and X. Further suppose that in the past, the slope has been 1 and it will be
advantageous to show that it is now at least 1.2.
The analysis will look at the power of several sample sizes between 50 and 250. A superiority test will be used
with a significance level of 0.025. Based on previous studies, σe will be assumed to be 0.6. The value of σx will
assume that X is binary with equally-likely values of 1 and 2. The power will be computed at B1 = 0.9, 1, 1.1, and
1.2.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for Simple Linear Regression procedure window. You may
then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing
Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Higher Slopes Are................................... Better (H1: B > B0)
Alpha ....................................................... 0.025
N (Sample Size)...................................... 50 100 150 200 250
B0 (Superiority Slope)............................. 1.2
B1 (Slope|H1) ......................................... 1.3 1.4 1.5
σх Input Type .......................................... List of X Values
List of X Values ....................................... 1 2
σe Input Type.......................................... σe (Std Dev of Residuals)
σe (Std Dev of Residuals) ...................... 0.6

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: B ≤ B0 vs. H1: B > B0

Power
0.0834
0.2104
0.4100
0.1282
0.3784
0.6969
0.1721
0.5271
0.8604
0.2156
0.6501
0.9404
0.2587
0.7470
0.9760

Sample
Size
N
50
50
50
100
100
100
150
150
150
200
200
200
250
250
250

Superiority
Slope
B0
1.200
1.200
1.200
1.200
1.200
1.200
1.200
1.200
1.200
1.200
1.200
1.200
1.200
1.200
1.200

Actual
Slope
B1
1.300
1.400
1.500
1.300
1.400
1.500
1.300
1.400
1.500
1.300
1.400
1.500
1.300
1.400
1.500

Std
Dev
of X
σх
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500

Std
Dev
of Y
σʏ
0.885
0.922
0.960
0.885
0.922
0.960
0.885
0.922
0.960
0.885
0.922
0.960
0.885
0.922
0.960

Std
Dev
of
Resids
σe
0.600
0.600
0.600
0.600
0.600
0.600
0.600
0.600
0.600
0.600
0.600
0.600
0.600
0.600
0.600

R²
0.540
0.576
0.610
0.540
0.576
0.610
0.540
0.576
0.610
0.540
0.576
0.610
0.540
0.576
0.610

Alpha
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
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Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the size of the sample drawn from the population. To conserve resources, it should be small.
B0 is the superiority slope (boundary) in the case in which HIGHER slope values are desired.
B1 is the slope at which the power is calculated.
σх is the standard deviation of the X values.
σʏ is the standard deviation of Y (ignoring X).
σe is the standard deviation of the residuals.
R² is the R-squared when Y is regressed on X.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements ─────────────────────────────────────────────────────────
A superiority by a margin test is planned in which HIGHER slope values are desired. A sample
size of 50 achieves 8% power to detect a change in slope from 1.200 under the null hypothesis
to 1.300 under the alternative hypothesis when the statistical hypothesis is one-sided, the
significance level is 0.025, the standard deviation of X is 0.500, the standard deviation of Y
is 0.885, the standard deviation of residuals is 0.600, and R² is 0.540.

This report shows the calculated power for each of the scenarios.

Plots Section

These plots show the power versus the sample size for the three values of B1.
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Example 2 – Validation using Another PASS Procedure
We could not find a validation example for this procedure in the literature. But since this procedure was derived
from the Non-Zero Null Tests for Simple Linear Regression procedure, we will use an example from that
previously validated procedure to validate this procedure.
In the other procedure, set the Solve For parameter to Sample Size. Also, set the Alternative Hypothesis to OneSided (H1: B > B0). Also, set 𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 = 0.9, 𝐵𝐵0 = 1.2, 𝐵𝐵1 = 1.4, 𝛼𝛼 = 0.05, 𝜎𝜎𝑋𝑋 = 0.5, 𝜎𝜎𝑒𝑒 = 0.6.
The sample size is calculated as 310.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for Simple Linear Regression procedure window. You may
then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing
Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Higher Slopes Are................................... Better (H1: B > B0)
Power ...................................................... 0.90
Alpha ....................................................... 0.05
B0 (Superiority Slope)............................. 1.2
B1 (Slope|H1) ......................................... 1.4
σх Input Type .......................................... σх (Std Dev of X)
σх (Std Dev of X) .................................... 0.5
σe Input Type.......................................... σe (Std Dev of Residuals)
σe (Std Dev of Residuals) ...................... 0.6

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: B ≤ B0 vs. H1: B > B0

Power
0.9003

Sample
Size
N
310

Superiority
Slope
B0
1.200

Actual
Slope
B1
1.400

Std
Dev
of X
σх
0.500

Std
Dev
of Y
σʏ
0.922

Std
Dev
of
Resids
σe
0.600

R²
0.576

Alpha
0.050

The sample size of 310 matches the result from the other procedure.
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